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Chapter 1 
Introduction 

The program performs the following design, check, or analysis processes:  

 Design and check of concrete wall piers for flexural and axial loads  

 Design of concrete wall piers for shear  

 Design of concrete shear wall spandrels for flexure  

 Design of concrete wall spandrels for shear  

Initiation of the design process, along with control of various design parameters, 
is accomplished using the Design menu. 

Automated design at the object level is available as long as the structures have 
first been modeled and analyzed by the program. Model and analysis data, such 
as material properties and member forces, are recovered directly from the model 
database, and no additional user input is required if the design defaults are 
acceptable.  

The design is based on a set of user-specified loading combinations. However, 
the program provides default load combinations for each design code supported 
in the program. If the default load combinations are acceptable, no definition of 
additional load combinations is required.  
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The program supports a range of shear wall design codes, including many 
national building codes. This manual is dedicated to the use of the menu option 
"BS 8110-1997." This option covers the “Code of Practice for Structural Use of 
Concrete 1987” (BS 1997) (incorporating the Amendments No. 1, 2 and 3). The 
details of the shear wall design and stress check algorithms used by the program 
when the user selects the BS 8110-1997 design code are described in this 
manual.  

The program provides detailed output data for Simplified pier section design, 
Section Designer pier section design, Section Designer pier section check, and 
Spandrel design.  

1.1 Organization 
This manual is designed to help you quickly become productive with the shear 
wall design options of the BS 8110-1997 code. Chapter 2 provides detailed 
descriptions of the Design Prerequisites used for BS 8110-1997. Chapter 3 
provides detailed descriptions of the design and check of concrete wall piers for 
flexural and axial loads and the design of concrete wall piers for shear in 
accordance with the BS 8110-1997 code. Chapter 4 provides detailed 
descriptions of design of concrete shear wall spandrels for flexure and design of 
concrete wall spandrels for shear in accordance with the BS 8110-1997 code. 
The appendices provide details on certain topics referenced in this manual.  

1.2 Recommended Reading/Practice 
It is strongly recommended that you read this manual and review any applicable 
“Watch & Learn” Series™ tutorials, which are found on our web site, 
http://www.csiberkeley.com, before attempting to design a shear wall. 
Additional information can be found in the on-line Help facility available from 
within the program’s main menu. 
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Chapter 2  
Design Prerequisites 

This chapter identifies the various notations used in this manual. The default 
load combinations when the user selects the BS 8110-1997 design code are 
described. Additionally, preferences and overwrites are introduced, and units 
applied when the user selects the BS 8110-1997 design code also are 
identified. 

The design is based on loading combinations specified by the user. To 
facilitate the design process, the program provides a set of default load 
combinations that should satisfy requirements for the design of most building 
type structures.  

2.1 Notation  
Following are the notations used in this manual. 

Acv Net area of a wall pier bounded by the length of the wall pier, 
Lp, and the web thickness, tp, mm2 

Ag Gross area of a wall pier, mm2 
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Ah-min Minimum required area of distributed horizontal reinforcing 
steel required for shear in a wall spandrel, mm2 / mm 

As Area of reinforcing steel, mm 2 

Asc Area of reinforcing steel required for compression in a pier edge 
member, or the required area of tension steel required to balance 
the compression steel force in a wall spandrel, mm 2 

Asc-max Maximum area of compression reinforcing steel in a wall pier 
edge member, mm 2 

Asf The required area of tension reinforcing steel for balancing the 
concrete compression force in the extruding portion of the con-
crete flange of a T-beam, mm 2 

Ast Area of reinforcing steel required for tension in a pier edge 
member, mm 2 

Ast-max Maximum area of tension reinforcing steel in a wall pier edge 
member, mm 2 

Asv Area of reinforcing steel required for shear, mm 2 / mm 

Avd Area of diagonal shear reinforcement in a coupling beam, mm 2 

Av-min Minimum required area of distributed vertical reinforcing steel 
required for shear in a wall spandrel, mm 2 / mm 

Asw The required area of tension reinforcing steel for balancing the 
concrete compression force in a rectangular concrete beam, or 
for balancing the concrete compression force in the concrete 
web of a T-beam, mm 2 

A's Area of compression reinforcing steel in a spandrel, mm 2 

B1, B2... Length of a concrete edge member in a wall with uniform thick-
ness, mm 

Cc Concrete compression force in a wall pier or spandrel, N 

2-2 Notation 
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Cf Concrete compression force in the extruding portion of a T-
beam flange, N 

Cs Compression force in wall pier or spandrel reinforcing steel, N 

Cw Concrete compression force in the web of a T-beam, N 

D/C Demand/Capacity ratio as measured on an interaction curve for a 
wall pier, unitless 

DB1 Length of a user-defined wall pier edge member, mm. This can 
be different on the left and right sides of the pier, and it also can 
be different at the top and the bottom of the pier.  

DB2 Width of a user-defined wall pier edge member, mm. This can 
be different on the left and right sides of the pier, and it also can 
be different at the top and the bottom of the pier. 

Es Modulus of elasticity of reinforcing steel, MPa. 

IP-max The maximum ratio of reinforcing considered in the design of a 
pier with a Section Designer section, unitless 

IP-min The minimum ratio of reinforcing considered in the design of a 
pier with a Section Designer section, unitless 

LBZ Horizontal length of the boundary zone at each end of a wall 
pier, mm 

Lp Horizontal length of wall pier, mm. This can be different at the 
top and the bottom of the pier 

Ls Horizontal length of wall spandrel, mm 

Qk Live load 

M Factored bending moment at a design section, N-mm 

Mc In a wall spandrel with compression reinforcing, the factored 
bending moment at a design section resisted by the couple be-
tween the concrete in compression and the tension steel, N-mm 
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Mf In a wall spandrel with a T-beam section and compression 
reinforcing, the factored bending moment at a design section 
resisted by the couple between the concrete in compression in 
the extruding portion of the flange and the tension steel, N-mm 

Ms In a wall spandrel with compression reinforcing, the factored 
bending moment at a design section resisted by the couple 
between the compression steel and the tension steel, N-mm 

Mw In a wall spandrel with a T-beam section and compression 
reinforcing, the factored bending moment at a design section 
resisted by the couple between the concrete in compression in 
the web and the tension steel, N-mm 

OC On a wall pier interaction curve the "distance" from the origin to 
the capacity associated with the point considered 

OL On a wall pier interaction curve the "distance" from the origin to 
the point considered 

Nb The axial force in a wall pier at a balanced strain condition, N 

Nleft Equivalent axial force in the left edge member of a wall pier 
used for design, N. This may be different at the top and the bot-
tom of the wall pier. 

Nmax Limit on the maximum compressive design strength specified by 
BS 8110-1997, N. 

Nr Nominal axial strength, N. 

NO Nominal axial load strength of a wall pier, N. 

Nr,max The maximum compression force a wall pier can carry with 
strength reduction factors set equal to one, N. 

Nt,max The maximum tension force a wall pier can carry with strength 
reduction factors set equal to one, N. 

2-4 Notation 
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Nright Equivalent axial force in the right edge member of a wall pier 
used for design, N. This may be different at the top and the bot-
tom of the wall pier. 

N Factored axial force at a design section, N. 

NCmax Maximum ratio of compression steel in an edge member of a 
wall pier, unitless 

NTmax Maximum ratio of tension steel in an edge member of a wall 
pier, unitless 

RLW Shear strength reduction factor as specified in the concrete mate-
rial properties, unitless. This reduction factor applies to light-
weight concrete. It is equal to 1 for normal weight concrete. 

RLL Reduced live load 

Ns Tension force in wall pier reinforcing steel, N. 

Vc The portion of the shear force carried by the concrete, N. 

Vr Design shear strength, N. 

Vs The portion of the shear force in a spandrel carried by the shear 
reinforcing steel, N. 

V Factored shear force at a design section, N. 

Wk Wind load 

a Depth of the wall pier or spandrel compression block, mm 

a1 Depth of the compression block in the web of a T-beam, mm 

bs Width of the compression flange in a T-beam, mm. This can be 
different on the left and right ends of the T-beam. 

c Distance from the extreme compression fiber of the wall pier or 
spandrel to the neutral axis, mm 
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dr-bot Distance from bottom of spandrel beam to centroid of the bot-
tom reinforcing steel, mm. This can be different on the left and 
right ends of the beam. 

dr-top Distance from top of spandrel beam to centroid of the top rein-
forcing steel, mm. This can be different on the left and right 
ends of the beam. 

ds Depth of the compression flange in a T-beam, mm. This can be 
different on the left and right ends of the T-beam. 

dspandrel Depth of spandrel beam minus cover to centroid of reinforcing, 
mm 

fy Yield strength of steel reinforcing, N/mm2. This value is used 
for flexural and axial design calculations. 

fys Yield strength of steel reinforcing, N/mm2. This value is used 
for shear design calculations. 

f 'cu Concrete compressive strength, N/mm2. This value is used for 
flexural and axial design calculations. 

f 'cs Concrete compressive strength, N/mm2. This value is used for 
shear design calculations. 

f 's Stress in compression steel of a wall spandrel, N/mm2. 

hs Height of a wall spandrel, mm. This can be different on the left 
and right ends of the spandrel. 

k1 Shear strength enhancement factor. 

k2 Concrete shear strength factor. [fcu/25]1/3 

pmax Maximum ratio of reinforcing steel in a wall pier with a Section 
Designer section that is designed (not checked), unitless. 

pmin Minimum ratio of reinforcing steel in a wall pier with a Section 
Designer section that is designed (not checked), unitless. 

2-6 Notation 
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tp Thickness of a wall pier, mm. This can be different at the top 
and bottom of the pier. 

ts Thickness of a wall spandrel, mm. This can be different on the 
left and right ends of the spandrel. 

ΣGk The sum of all dead load cases 

Σ Qk The sum of all live load cases 

ΣRQk The sum of all reduced live load cases 

x Neutral axis depth, mm 

xbal Depth of neutral axis in balanced condition, mm 

z Lever arm, mm 

ε Reinforcing steel strain, unitless 

εc Maximum allowed compression strain in concrete, 0.0035. 

εs Reinforcing steel strain in a wall pier, unitless 

ε 's Compression steel strain in a wall spandrel, unitless 

γm Partial safety factor for strength of materials (BS 2.4.4.1). 

1.15,    for reinforcement,
1.50,   for concrete in flexure and axial load, and
1.25,   for shear strength without shear reinforcement.

m


γ = 



    

2.2 Design Station Locations 
The program designs wall piers at stations located at the top and bottom of 
the pier only. To design at the mid-height of a pier, break the pier into two 
separate "half-height" piers. 

The program designs wall spandrels at stations located at the left and right 
ends of the spandrel only. To design at the mid-length of a spandrel, break 
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the spandrel into two separate "half-length" piers. Note that if a spandrel is 
broken into pieces, the program will calculate the seismic diagonal shear 
reinforcing separately for each piece. The angle used to calculate the seismic 
diagonal shear reinforcing for each piece is based on the length of the piece, 
not the length of the entire spandrel.  

2.3 Default Design Load Combinations 
The design load combinations automatically created by the program for 
concrete shear wall design are given by Equations 1 through 8 (BS 2.4.3). 

1.4ΣGk Eqn. 1 

1.4ΣGk + 1.6(ΣQk + ΣRQk) Eqn. 2 

1.2ΣGk + 1.2(ΣQk + ΣRQk) + 1.2Wk Eqn. 3 

1.2ΣGk + 1.2(ΣQk + ΣRQk) - 1.2Wk Eqn. 4 

1.4ΣGk +1.4Wk Eqn. 5 

1.4ΣGk − 1.4Wk Eqn. 6 

1.0ΣGk +1.4Wk Eqn. 7 

1.0ΣGk − 1.4Wk Eqn. 8 

In Equations 1 through 8, 

ΣGk = The sum of all dead load (DL) load cases defined for the model. 

ΣQk = The sum of all live load (LL) load cases defined for the model. 
Note that this includes roof live loads as well as floor live loads. 

ΣRQk = The sum of all reducible live load (RLL) load cases defined for 
the model. 

Wk = Any single wind load (WL) load case defined for the model. 

2-8 Default Design Load Combinations 
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2.3.1 Dead Load Component 
The dead load component of the default design load combinations consists of 
the sum of all dead loads multiplied by the specified factor. Individual dead 
load cases are not considered separately in the default design load 
combinations. 

2.3.2 Live Load Component 
The live load component of the default design load combinations consists of 
the sum of all live loads, both reducible and nonreducible, multiplied by the 
specified factor. Individual live load cases are not considered separately in 
the default design load combinations. 

2.3.3 Wind Load Component 
The wind load component of the default design load combinations consists of 
the contribution from a single wind load case. Thus, if multiple wind load 
cases are defined in the program model, each of Equations 3 through 8 will 
contribute multiple design load combinations, one for each wind load case 
that is defined. 

2.3.4 Combinations That Include Static Nonlinear Results 
The default shear wall design load combinations do not include any static 
nonlinear results. To include static nonlinear results in a design load 
combination, define the load combination yourself. 

If a design load combination includes a single static nonlinear case and 
nothing else, the design is performed for each step of the static nonlinear 
analysis. Otherwise, the design is performed for the last step of the static 
nonlinear analysis only. 

2.4 Shear Wall Design Preferences 
The shear wall design preferences are basic properties that apply to all wall 
pier and spandrel elements. Appendix A identifies shear wall design 
preferences for BS 8110-1997.  
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Default values are provided for all shear wall design preference items. Thus, 
it is not required that preferences be specified. However, at least review the 
default values for the preference items to make sure they are acceptable. 

2.5 Shear Wall Design Overwrites 
The shear wall design overwrites are basic assignments that apply only to 
those piers or spandrels to which they are assigned. The overwrites for piers 
and spandrels are separate. Appendix B identifies the shear wall overwrites 
for BS 8110-1997. Note that the available overwrites change depending on 
the pier section type (Uniform Reinforcing, General Reinforcing, or 
Simplified T and C).   

Default values are provided for all pier and spandrel overwrite items. Thus, it 
is not necessary to specify or change any of the overwrites. However, at least 
review the default values for the overwrite items to make sure they are 
acceptable. When changes are made to overwrite items, the program applies 
the changes only to the elements to which they are specifically assigned; that 
is, to the elements that are selected when the overwrites are changed. 

2.6 Choice of Units 
For shear wall design in this program, any set of consistent units can be used 
for input. Also, the system of units being used can be changed at any time. 
Typically, design codes are based on one specific set of units.  

The BS 8110-1997 code is based on Newton-millimeter-Second units. For 
simplicity, all equations and descriptions presented in this manual correspond 
to Newton-millimeter-second units unless otherwise noted.  

The shear wall design preferences allow the user to specify special units for 
concentrated and distributed areas of reinforcing. These units are then used 
for reinforcing in the model, regardless of the current model units displayed 
in the drop-down list on the status bar (or within a specific form). The special 
units specified for concentrated and distributed areas of reinforcing can only 
be changed in the shear wall design preferences. 

2-10 Shear Wall Design Overwrites 
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The choices available in the shear wall design preferences for the units 
associated with an area of concentrated reinforcing are in2, cm2, mm2, and 
current units. The choices available for the units associated with an area per 
unit length of distributed reinforcing are in2/ft, cm2/m. mm2/m, and current 
units. 

The current units option uses whatever units are currently displayed in the 
drop-down list on the status bar (or within a specific form). If the current 
length units are m, this option means concentrated areas of reinforcing are in 
m2 and distributed areas of reinforcing are in m2/m. Note that when using the 
"current" option, areas of distributed reinforcing are specified in 
Length2/Length units, where Length is the currently active length unit. For 
example, if you are working in kN and m units, the area of distributed 
reinforcing is specified in m2/m. If you are in kN and mm, the area of 
distributed reinforcing is specified in m2/mm. 
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Chapter 3 
Pier Design 

This chapter describes how the program designs each leg of concrete wall piers 
for shear using BS 8110-1997. Reference to the BS 8110-1997 code in this 
chapter is identified with the prefix “BS.” Note that in this program shear 
reinforcing cannot be specified and then be checked by the program. The 
program only designs the pier for shear and reports how much shear 
reinforcing is required. The shear design is performed at stations at the top and 
bottom of the pier. 

This chapter also describes how the program designs and checks concrete wall 
piers for flexural and axial loads using BS 8110-1997. First we describe how 
the program designs piers that are specified by a simplified section. Next we 
describe how the program checks piers that are specified using the Section 
Designer utility. Then we describe how the program designs piers that are 
specified using the Section Designer utility. 

3.1 Wall Pier Flexural Design 
For both designing and checking piers, it is important to understand the local 
axis definition for the pier. Access the local axes assignments using the Assign 
menu. 
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3.1.1 Designing a Simplified Pier Section 
This section describes how the program designs a pier that is assigned a simpli-
fied section. The geometry associated with the simplified section is illustrated 
in Figure 3-1. The pier geometry is defined by a length, thickness and size of 
the edge members at each end of the pier (if any).  

 

Figure 3-1: Typical Wall Pier Dimensions Used for Simplified Design 

A simplified T and C pier section is always planar (not three-dimensional). The 
dimensions shown in the figure include the following: 

 The length of the wall pier is designated Lp. This is the horizontal length of 
the wall pier in plan. 

 The thickness of the wall pier is designated tp. The thickness specified for 
left and right edge members (DB2left and DB2right) may be different from 
this wall thickness. 

3-2 Wall Pier Flexural Design 
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 DB1 represents the horizontal length of the pier edge member. DB1 can be 
different at the left and right sides of the pier. 

 DB2 represents the horizontal width (or thickness) of the pier edge 
member. DB2 can be different at the left and right sides of the pier. 

The dimensions illustrated are specified in the shear wall overwrites (Appendix 
B) and can be specified differently at the top and bottom of the wall pier. 

If no specific edge member dimensions have been specified by the user, the 
program assumes that the edge member is the same width as the wall, and the 
program determines the required length of the edge member. In all cases, 
whether the edge member size is user-specified or program-determined, the 
program reports the required area of reinforcing steel at the center of the edge 
member. This section describes how the program-determined length of the 
edge member is determined and how the program calculates the required rein-
forcing at the center of the edge member. 

Three design conditions are possible for a simplified wall pier. These condi-
tions are illustrated in Figure 3-2. 

Design Condition 2
Wall pier with user-defined edge
members

Design Condition 1
Wall pier with uniform thickness and
ETABS-determined (variable length)
edge members

Design Condition 3
Wall pier with a user-defined edge
member on one end and an ETABS-
determined (variable length) edge
member on the other end

Note:
In all three conditions, the only
reinforcing designed by ETABS is that
required at the center of the edge
members  

Figure 3-2: Design Conditions for Simplified Wall Piers 
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 The wall pier has program-determined (variable length and fixed width) edge 
members on each end. 

 The wall pier has user-defined (fixed length and width) edge members on 
each end. 

 The wall pier has a program-determined (variable length and fixed width) 
edge member on one end and a user-defined (fixed length and width) edge 
member on the other end. 

3.1.1.1 Design Condition 1 
Design condition 1 applies to a wall pier with uniform design thickness and 
program-determined edge member length. For this design condition, the design 
algorithm focuses on determining the required size (length) of the edge mem-
bers, while limiting the compression and tension reinforcing located at the 
center of the edge members to user-specified maximum ratios. The maximum 
ratios are specified in the shear wall design preferences and the pier design 
overwrites as Edge Design NC-Max and Edge Design NT-Max. 

Consider the wall pier shown in Figure 3-3. For a given design section, say the 
top of the wall pier, the wall pier for a given design load combination is 
designed for a factored axial force N-top and a factored moment M-top.  

The program initiates the design procedure by assuming an edge member at the 
left end of the wall with a thickness tp and width B1-left, and an edge member at 
the right end of the wall with a thickness tp and width B1-right. Initially B1-left = 
B1-right = tp. 

The moment and axial force are converted to an equivalent force set Nleft-top and 
Nright-top using the relationships shown in the following equations. (Similar 
equations apply at the bottom of the pier.) 

 
( )

top top
left-top

1 left 1 right2 0.5 0.5p

N M
N

L B B
− −

− −

= +
− −

 

 
( )

top top
right-top

1 left 1 right2 0.5 0.5p

N M
N

L B B
− −

− −

= −
− −

 

3-4 Wall Pier Flexural Design 



Chapter 3 Pier Design 

B1-right

tp

t p

B2-right

B3-right

0.5Lp

0.5tp
tp

0.5tp

B1-left

B2-left

B3-left

CL
Wall Pier Plan

Pu-top

Mu-top

Pu-bot

Mu-bot

Pright-botPleft-bot

Pright-topPleft-top

Le
ft e

dg
e m

em
be

r

Ri
gh

t e
dg

e m
em

be
r

Wall Pier Elevation

Lp

Top of 
pier

Bottom
 of pier

 

Figure 3-3: Wall Pier for Design Condition 1 
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For any given loading combination, the net values for set Nleft-top and Nright-top 
could be tension or compression. 

Note that for dynamic loads, set Nleft-top and Nright-top are obtained at the modal 
level and the modal combinations are made, before combining with other 
loads. Also for design loading combinations involving SRSS, the set Nleft-top 
and Nright-top forces are obtained first for each load case before the combinations 
are made. 

If any value of Nleft-top or Nright-top is tension, the area of steel required for ten-
sion, Ast, is calculated as: 

 st
y s

NA
f

=
γ

  (BS 3.4.4.1) 

If any value of Nleft-top or Nright-top is compression, for section adequacy, the area 
of steel required for compression, Asc, must satisfy the following relationship. 

 ( )( ) 0.67 ycu
g sc sc

c s

ffAbs N A A A = − + γ γ 
 (BS 3.4.4.1) 

where N is either Nleft-top or Nright-top, Ag = tpB1 and the Pmax Factor is defined in 
the shear wall design preferences (the default is 1.0). In general, we recom-
mend that you use the default value.  

  
( ) 0.67

0.67
cu c g

sc
y s cu c

Abs N f A
A

f f
− γ

=
γ − γ

. 

If Asc calculates as negative, no compression reinforcing is needed. 

The maximum tensile reinforcing to be packed within the tp times B1 concrete 
edge member is limited by: 

 -max max 1.st pA NT t B=  

Similarly, the compression reinforcing is limited by: 

 -max max 1.sc pA NC t B=  

If Ast is less than or equal to Ast-max and Asc is less than or equal to Asc-max, the 
program will proceed to check the next loading combination; otherwise the 
program will increment the appropriate B1 dimension (left, right or both, 
depending on which edge member is inadequate) by one-half of the wall 
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thickness to B2 (i.e., 1.5tp) and calculate new values for Nleft-top and Nright-top 
resulting in new values of Ast and Asc. This iterative procedure continues until 
Ast and Asc are within the allowed steel ratios for all design load combinations. 

If the value of the width of the edge member B increments to where it reaches a 
value larger than or equal to Lp /2, the iteration is terminated and a failure con-
dition is reported. 

This design algorithm is an approximate but convenient algorithm. Wall piers 
that are declared overstressed using this algorithm could be found to be ade-
quate if the reinforcing steel is user-specified and the wall pier is accurately 
evaluated using interaction diagrams. 

3.1.1.2 Design Condition 2 
Design condition 2 applies to a wall pier with user-specified edge members at 
each end of the pier. The size of the edge members is assumed to be fixed; that 
is, the program does not modify them. For this design condition, the design al-
gorithm determines the area of steel required in the center edge members and 
checks if that area gives reinforcing ratios less than the user-specified maxi-
mum ratios. The design algorithm used is the same as described for condition 
1; however, no iteration is required. 

3.1.1.3 Design Condition 3 
Design condition 3 applies to a wall pier with a user-specified (fixed dimen-
sion) edge member at one end of the pier and a variable length (program-
determined) edge member at the other end. The width of the variable length 
edge member is equal to the width of the wall.  

The design is similar to that which previously has been described for design 
conditions 1 and 2. The size of the user-specified edge member is not changed. 
Iteration occurs on the size of the variable length edge member only. 

3.1.2 Checking a General or Uniform Reinforcing Pier Section 
When a General Reinforcing or Uniform Reinforcing pier section is specified 
to be checked, the program creates an interaction surface for that pier and uses 
that interaction surface to determine the critical flexural demand/capacity ratio 
for the pier. This section describes how the program generates the interaction 
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surface for the pier and how it determines the demand/capacity ratio for a given 
design load combination. 

Note:  In this program, the interaction surface is defined by a series of NMM 
interaction curves that are equally spaced around a 360-degree circle. 

3.1.2.1 Interaction Surface 
In this program, a three-dimensional interaction surface is defined with refer-
ence to the N, M2 and M3 axes. The surface is developed using a series of in-
teraction curves that are created by rotating the direction of the pier neutral axis 
in equally spaced increments around a 360 degree circle. For example, if 24 
PMM curves are specified (the default), there is one curve every 15 degrees 
(360°/24 curves = 15°). Figure 3-4 illustrates the assumed orientation of the 
pier neutral axis and the associated sides of the neutral axis where the section is 
in tension (designated T in the figure) or compression (designated C in the fig-
ure) for various angles. 

Note that the orientation of the neutral axis is the same for an angle of θ and  
θ +180°. The side of the neutral axis where the section is in tension or com-
pression is the only side that changes. We recommend use of 24 interaction 
curves (or more) to define a three-dimensional interaction surface. 

Each NMM interaction curve that makes up the interaction surface is numerical-
ly described by a series of discrete points connected by straight lines. The coor-
dinates of those points are determined by rotating a plane of linear strain about 
the neutral axis on the section of the pier. Details of this process are described 
later in the section entitled "Details of the Strain Compatibility Analysis." 

By default, 11 points are used to define a NMM interaction curve. This number 
can be changed in the preferences; any odd number of points greater than or 
equal to 11 can be specified, to be used in creating the interaction curve. If an 
even number is specified for this item in the preferences, the program will in-
crement up to the next higher odd number. 

Note that when creating an interaction surface for a two-dimensional wall pier, 
the program considers only two interaction curvesthe 0° curve and the 180° 
curveregardless of the number of curves specified in the preferences. Fur-
thermore, only moments about the M3 axis are considered for two-dimensional 
walls.  
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Figure 3-4: Orientation of the Pier Neutral Axis for Various Angles 

3.1.2.2 Formulation of the Interaction Surface 
The formulation of the interaction surface in this program is based consistently 
on the basic principles of ultimate strength design given in Sections 6.2.1.4 of 
BS 8110-1997. The program uses the requirements of force equilibrium and 
strain compatibility to determine the design axial load and moment strength 
(Nr, M2r, M3r) of the wall pier. For the pier to be deemed adequate, the required 
strength (N, M2, M3) must be less than or equal to the design strength, as indi-
cated in the following equation.  

 (N, M2, M3) ≤ (Nr, M2r, M3r) 

The effects of the partial safety factors for concrete ( cγ = 1.50) and for steel 
( sγ = 1.15) are included in the generation of the interaction curve (BS 1.4, BS 
2.4.4.1, Table 2.2) 

cγ = Partial safety factor for concrete. The value is taken as 1.5 (BS 2.4.4.1, 
Table 2.2). 
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sγ = Partial safety factor for reinforcing steel. The value is taken as 1.15 (BS 
2.4.4.1, Table 2.2). 

The theoretical maximum compressive force that the wall pier can carry is des-
ignated Nr,max and is given as follows: 

 Nr,max = [0.67(fcu /γc) (Ag − As) + fy /γs As] (BS 3.4.4.1) 

The theoretical maximum tension force that the wall pier can carry is designat-
ed Nt,max and is given by: 

 Nt,max = (fy /γs)As   (BS 3.4.4.1) 

If the wall pier geometry and reinforcing is symmetrical in plan, the moments 
associated with both Nr,max and Nt,max are zero. Otherwise, a moment associated 
will be with both Nr,max and Nt,max. 

In addition to Nr,max and Nt,max, the axial load at the balanced strain condition, 
i.e., Nb, is also determined. In this condition, the tension reinforcing reaches the 
strain corresponding to its specified yield strength modified by a corresponding 
partial factor of safety, fy/γms, as the concrete reaches its assumed ultimate 
strain. 

Note: The number of points to be used in creating interaction diagrams can be speci-
fied in the shear wall preferences and overwrites. 

As previously mentioned, by default, 11 points are used to define a single in-
teraction curve. When creating a single interaction curve, the program includes 
the points at Nb, Noc and Not on the interaction curve. Half of the remaining 
number of specified points on the interaction curve occur between Nb and Noc 
at approximately equal spacing along the N axis. The other half of the remain-
ing number of specified points on the interaction curve occur between Nb and 
Not at approximately equal spacing along the N axis. 

Figure 3-7 shows a plan view of an example two-dimensional wall pier. Notice 
that the concrete is symmetrical but the reinforcing is not symmetrical in this 
example.  
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Figure 3-7: Example Two-Dimensional Wall Pier With Unsymmetrical Reinforcing  

Figure 3-8 shows several interaction surfaces for the wall pier illustrated in Figure 3-7.   
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Figure 3-8 : Interaction Curves for Example Wall Pier Shown in Figure 3-7 

Note the following about Figure 3-8: 

 Because the pier is two-dimensional, the interaction surface consists of two 
interaction curves. One curve is at 0° and the other is at 180°. Only M3 
moments are considered because this is a two-dimensional example. 
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 In this program, compression is negative and tension is positive. 

 The 0° and 180° interaction curves are not symmetric because the wall pier 
reinforcing is not symmetric. 

 The interaction surfaces shown are created using the default value of 11 
points for each interaction curve. 

Figure 3-9 shows the 0° interaction curves for the wall pier illustrated in Figure 
3-7. Additional interaction curves are also added to Figure 3-9.  
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Figure 3-9: Interaction Curves for Example Wall Pier Shown in Figure 3-7 

3.1.2.3 Details of the Strain Compatibility Analysis 
As previously mentioned, the program uses the requirements of force equili-
brium and strain compatibility to determine the factored axial load and moment 
strength (N, M2, M3) of the wall pier. The coordinates of these points are 
determined by rotating a plane of linear strain on the section of the wall pier. 
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Figure 3-10 illustrates varying planes of linear strain such as those that the pro-
gram considers on a wall pier section for a neutral axis orientation angle of 0 
degrees. 
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Figure 3-10: Varying Planes of Linear Strain 

The linear strain diagram limits the maximum concrete strain, at the extremity 
of the section, to εc,max (BS 3.4.4.1) as shown by the following: 

0.0035cε =        (BS 3.4.4.1) 

In these planes, the maximum concrete strain is always taken as εc,max (BS 
3.4.4.1), and the maximum steel strain is varied from εc,max to plus infinity. 

Recall that in this program compression is negative and tension is positive.  

When the steel strain is εc,max, the maximum compressive force in the wall pier, 
Noc, is obtained from the strain compatibility analysis. When the steel strain is 
plus infinity, the maximum tensile force in the wall pier, Not, is obtained. When 
the maximum steel strain is equal to the yield strain for the reinforcing, Nb is 
obtained. 
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Figure 3-11 illustrates the concrete wall pier stress-strain relationship that is 
obtained from a strain compatibility analysis of a typical plane of linear strain 
shown in Figure 3-10. In Figure 3-11 the compressive stress in the concrete, 
Cc, is calculated using the following equation. 

 0.67 cu
c p

c

f
C at=

γ
  (BS 3.4.4.1, Figure 3.3) 

the depth of compression block, a, is given by: 

0.9=a x  (BS 3.4.4.1, Figure 3.3) 

 

Figure 3-11: Wall Pier Stress-Strain Relationship 
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In Figure 3-10, the value for maximum strain in the reinforcing steel is as-
sumed. Then the strain in all other reinforcing steel is determined based on the 
assumed plane of linear strain. Next the stress in the reinforcing steel is calcu-
lated using the following equation, where εs is the strain, Es is the modulus of 
elasticity, σs is the stress, and fy is the yield stress of the reinforcing steel. 

 σs = εsEs ≤ fy /γs (BS 3.4.4.1, Figure 2.2) 

The force in the reinforcing steel (Ts for tension or Cs for compression) is cal-
culated using the preceding equation where: 

 Ts or Cs = σsAs (BS 3.4.4.1) 

For the given distribution of strain, the value of Nr is calculated using the fol-
lowing equation: 

 Nr = (ΣTs − Cc − ΣCs) ≤ Nmax (BS 3.4.4.1) 

In the previous equation, the tensile force Ts and the compressive forces Cc and 
Cs are all positive. If Nr is positive, it is tension, and if it is negative, it is com-
pression. The term Nmax is taken as Nr,max if Nr is compressive, and as Nt,max if 
Nr is tensile. 

The value of M2r is calculated by summing the moments due to all of the forc-
es about the pier local 2 axis. Similarly, the value of M3r is calculated by sum-
ming the moments due to all of the forces about the pier local 3 axis. The forc-
es whose moments are summed to determine M2r and M3r are Nr, Cc, all of the 
Ts forces and all of the Cs forces. 

The Nr, M2r and M3r values calculated as described in the preceding paragraph 
make up one point on the wall pier interaction diagram. Additional points on 
the diagram are obtained by making different assumptions for the maximum 
steel stress, that is, considering a different plane of linear strain, and repeating 
the process. 

When one interaction curve is complete, the next orientation of the neutral axis 
is assumed, and the points for the associated new interaction curve are calcu-
lated. This process continues until the points for all of the specified curves 
have been calculated. 
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3.1.3 Wall Pier Demand/Capacity Ratio 
Refer to Figure 3-12, which shows a typical two-dimensional wall pier interac-
tion diagram.  

 

Figure 3-12: Two-Dimensional Wall Pier Demand/Capacity Ratio 

The forces obtained from a given design load combination are N and M3. The 
point L, defined by (N, M3), is placed on the interaction diagram, as shown in 
the figure. If the point lies within the interaction curve, the wall pier capacity is 
adequate. If the point lies outside of the interaction curve, the wall pier is over-
stressed. 

As a measure of the stress condition in the wall pier, the program calculates a 
stress ratio. The ratio is achieved by plotting the point L and determining the 
location of point C. The point C is defined as the point where the line OL 
(extended outward if needed) intersects the interaction curve. The demand/ 
capacity ratio, D/C, is given by D/C = OL / OC where OL is the "distance" 
from point O (the origin) to point L and OC is the "distance" from point O to 
point C. Note the following about the demand/capacity ratio: 

 If OL = OC (or D/C = 1), the point (N, M3) lies on the interaction curve 
and the wall pier is stressed to capacity. 

 If OL < OC (or D/C < 1), the point (N, M3) lies within the interaction 
curve and the wall pier capacity is adequate. 
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 If OL > OC (or D/C > 1), the point (N, M3) lies outside of the interaction 
curve and the wall pier is overstressed. 

The wall pier demand/capacity ratio is a factor that gives an indication of the 
stress condition of the wall with respect to the capacity of the wall. The de-
mand/capacity ratio for a three-dimensional wall pier is determined in a similar 
manner to that described here for two-dimensional piers. 

3.1.4 Designing a General Reinforcing Pier Section 
When a General Reinforcing pier section is specified to be designed, the pro-
gram creates a series of interaction surfaces for the pier based on the following 
items: 

 The size of the pier as specified in Section Designer. 

 The location of the reinforcing specified in Section Designer. 

 The size of each reinforcing bar specified in Section Designer relative to the 
size of the other bars. 

The interaction surfaces are developed for eight different ratios of reinforcing-
steel-area-to-pier-area. The pier area is held constant and the rebar area is mod-
ified to obtain these different ratios; however, the relative size (area) of each 
rebar compared to the other bars is always kept constant. 

The smallest of the eight reinforcing ratios used is that specified in the shear 
wall design preferences as Section Design IP-Min. Similarly, the largest of the 
eight reinforcing ratios used is that specified in the shear wall design prefer-
ences as Section Design IP-Max. 

The eight reinforcing ratios used are the maximum and the minimum ratios 
plus six more ratios. The spacing between the reinforcing ratios is calculated as 
an increasing arithmetic series in which the space between the first two ratios is 
equal to one-third of the space between the last two ratios. Table 3-1 illustrates 
the spacing, both in general terms and for a specific example, when the mini-
mum reinforcing ratio, IPmin, is 0.0025 and the maximum, IPmax, is 0.02. 
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Table 3-1 The Eight Reinforcing Ratios Used by the Program 
Curve Ratio Example 

1 IPmin  0.0025 

2 
IPmax IPminIPmin +

14
−  0.0038 

3 
7 IPmax IPminIPmin +
3 14

− 
 
 

 0.0054 

4 
IPmax IPminIPmin + 4

14
− 

 
 

 0.0075 

5 
IPmax IPminIPmin + 6

14
− 

 
 

 0.0100 

6 
25 IPmax IPminIPmin +
3 14

− 
 
 

 0.0129 

7 
IPmax IPminIPmin + 11

14
− 

 
 

 0.0163 

8 IPmax  0.0200 

 
After the eight reinforcing ratios have been determined, the program develops 
interaction surfaces for all eight of the ratios using the process described earlier 
in the section entitled "Checking a General or Uniform Reinforcing Pier Sec-
tion." 

Next, for a given design load combination, the program generates a de-
mand/capacity ratio associated with each of the eight interaction surfaces. The 
program then uses linear interpolation between the eight interaction surfaces to 
determine the reinforcing ratio that gives a demand/capacity ratio of 1 (actually 
the program uses 0.99 instead of 1). This process is repeated for all design load 
combinations, and the largest required reinforcing ratio is reported. 

Design of a Uniform Reinforcing pier section is similar to that described herein 
for the General Reinforcing section. 

3.2 Wall Pier Shear Design 
The wall pier shear reinforcing is designed for each of the design load combi-
nations. The following steps are involved in designing the shear reinforcing for 
a particular wall pier section for a particular design loading combination. 
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 Determine the factored forces N, M and V that are acting on the wall pier sec-
tion. Note that N and M are required for the calculation of Vc. 

 Determine the shear force, Vc, that can be carried by the concrete. 

 Determine the required shear reinforcing to carry the balance of the shear 
force. 

Step 1 needs no further explanation. The following two sections describe in de-
tail the algorithms associated with the Steps 2 and 3. 

3.2.1 Determine the Concrete Shear Capacity 
Given the design force set N, M and V acting on a wall pier section, the shear 
force carried by the concrete, cv′ , is calculated as follows:  

 0.6 ,  c c
c

N Vhv v
A M

′ = + with  (BS 3.4.5.12) 

 
1 1

3 4
1 2 1000.79 400 ,s

c
m

Ak kv
bd d

   =    γ   
  (BS 3.4.5.4, Table 3.8) 

where,  

1k   is the enhancement factor for support compression  
and conservatively is taken as 1, (BS 3.4.5.8) 

1
3

2 ,
25

cuf
k  

=  
 

  (BS 3.4.5.4, Table 3.8) 

1.25.mγ =    (BS 2.4.4.1) 

However the following limitations also apply: 

 100
0.15 3,sA

bd
≤ ≤     (BS 3.4.5.4, Table 3.8) 

 1,Vh
M

≤  (BS 3.4.5.4, Table 3.8) 
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4 0.67for members without shear reinforcement

1.00 for members with shear reinforcement,   
400  
d

  ≥ 
 

(BS 3.4.5.4, Table 3.8) 

 2
N

mm40cuf ≤ ,   (BS 6.1.2.5, 6.1.2.5(c)) 

N/Ac is intended to be the average stress in the  
concrete acting at the centroid (BS 3.4.5.4, Table 3.8) 

As  is the area of tensile steel and it is taken as half the total reinforcing 
steel area, and 

d  is the distance from extreme compression fiber to the centroid of the 
tension steel. It is taken as 0.8 Lp. 

If the tension is large enough that ′cv results in a negative number, vc is set to 
zero. 

3.2.2 Determine the Required Shear Reinforcing 
Given V and vc, the following procedure provides the required shear reinforc-
ing in area per unit length (e.g., square millimeter per millimeter or optionally 
cm2/cm) for wall piers (BS 3.4.5.3, Table 3.7).  

, ,cv p
cv

Vv A t d
A

= =  where (BS 3.4.5.2) 

0.8 ,LW cuv R f≤  and (BS 3.4.5.2, BS 3.4.5.12) 

2
N

mm5v ≤ . (BS 3.4.5.2, BS 3.4.5.12) 

 If v exceeds 0.8 LW cuR f or 2
N

mm5 ,  the section area should be increased 

(BS 3.4.5.2, BS 3.4.5.12). 

Calculate the design average shear stress that can be carried by minimum 
transverse rebar, rv , as follows: 

2
N

mm0.4rv =    (BS 3.4.5.2, 3.4.5.12) 
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 If c rv v v′≤ +  provide minimum links defined by 

,
0.87

= r psv

v yv

v tA
s f

 (BS 3.4.5.3, Table 3.7) 

else if ,c rv v v′> +  provide links given by 

( )
.

0.87
′−

= c psv

v yv

v v tA
s f

  (BS BS 3.4.5.3, Table 3.7) 

Asv/sv is the horizontal shear reinforcing per unit vertical length (height) of the 
wall pier. In shear design, fy cannot be taken as greater than 460 MPa (BS 
3.4.5.1). If fy for shear rebar is defined as greater than 460 MPa, the program 
designs shear rebar based on fy equal to 460 MPa. 
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Chapter 4 
Spandrel Design 

This chapter describes how the program designs concrete shear wall spandrels 
for flexure and shear when BS 8110-1997 is the selected design code. 
Reference to the BS 8110-1997 code in this chapter is identified with the prefix 
“BS.”  The program allows consideration of rectangular sections and T-beam 
sections for shear wall spandrels. Note that the program designs spandrels at 
stations located at the ends of the spandrel. No design is performed at the 
center (mid-length) of the spandrel. The program does not allow shear 
reinforcing to be specified and then checked. The program designs the spandrel 
for shear only and reports how much shear reinforcing is required. 

4.1 Spandrel Flexural Design 
In this program, wall spandrels are designed for major direction flexure and 
shear only. Effects caused by any axial forces, minor direction bending, torsion 
or minor direction shear that may exist in the spandrels must be investigated by 
the user independent of the program. Spandrel flexural reinforcing is designed 
for each of the design load combinations. The required area of reinforcing for 
flexure is calculated and reported at the ends of the spandrel beam only. 
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The following steps are involved in designing the flexural reinforcing for a 
particular wall spandrel section for a particular design loading combination at a 
particular station. 

 Determine the maximum factored moment M. 

 Determine the required flexural reinforcing. 

These steps are described in the following sections. 

4.1.1 Determine the Maximum Factored Moments 
In the design of flexural reinforcing for spandrels, the factored moments for 
each design load combination at a particular beam station are first obtained.  

The beam section is then designed for the maximum positive and the maximum 
negative factored moments obtained from all of the design load combinations. 

4.1.2 Determine the Required Flexural Reinforcing 
In this program, negative beam moments produce top steel. In such cases, the 
beam is always designed as a rectangular section. 

In this program, positive beam moments produce bottom steel. In such cases, 
the beam may be designed as a rectangular section, or as a T beam section. 
Indicate that a spandrel is to be designed as a T beam by specifying the 
appropriate slab width and depth dimensions in the spandrel design overwrites 
(Appendix B). 

The flexural design procedure is based on the simplified rectangular stress 
block, as shown in Figure 4-1 (BS 3.4.4.1). Furthermore, it is assumed that 
moment redistribution in the member does not exceed 10% (i.e., βb ≥ 0.9) (BS 
6.1.2.4(b)). The code also places a limitation on the neutral axis depth,  to safe-
guard against non-ductile failures (BS 3.4.4.1). In addition, the area of 
compression reinforcement is calculated on the assumption that the neutral axis 
depth remains at the maximum permitted value. 

4-2 Spandrel Flexural Design 
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Figure 4-1  Rectangular Spandrel Beam Design, Positive Moment 

The design procedure used by the program, for both rectangular and flanged 
sections (L and T beams), is summarized in the subsections that follow. It is 
assumed that the design ultimate axial force does not exceed 0.1fcuAg (BS 
3.4.4.1); hence, all of the beams are designed for major direction flexure and 
shear only.  

It is assumed that the compression depth carried by the concrete is less than or 
equal to amax. When the applied moment exceeds the moment capacity at amax, 
the program calculates an area of compression reinforcement assuming that the 
additional moment is carried by compression reinforcing and additional tension 
reinforcing. 

The procedure used by the program for both rectangular and T beam sections is 
given in the subsections that follow.  

4.1.2.1 Rectangular Beam Flexural Reinforcing 
Refer to Figure 4-1. For rectangular beams, the moment capacity as a singly 
reinforced beam, Msingle, is obtained first for a section. The reinforcing steel 
area is determined based on whether M is greater than, less than, or equal to 
Msingle.  

 Spandrel Flexural Design 4-3 



Shear Wall Design BS 8110-1997 
 

 Calculate the ultimate moment of resistance of the section as singly 
reinforced. 

2
single ,  where cuM K f bd′=    (BS 3.4.4.4) 

' 0.156=K  

4.1.2.1.1 Tension Reinforcing Only Required 
If M ≤ Msingle, the area of tension reinforcement, As, is obtained from 

 
( )

,
0.87s

y

MA
f z

= where (BS 3.4.4.4) 

 0.5 0.25 0.95
0.9
Kz d d

  = + − ≤ 
 

, 

and, 

 2 .=
cu s

MK
f t d

 

The steel is placed at the bottom for positive moment and at the top for 
negative moment. 

Note: The program reports the ratio of top and bottom steel required in the web area. 
When compression steel is required, those ratios may be large because there is no 
limit on them. However, the program reports an overstress when the ratio exceeds 
4%. 

4.1.2.1.2 Tension and Compression Reinforcing Required 
If M > Msingle, the area of compression reinforcement, 'sA , is given by 

 
( )

single

0 67s
cu

s
m

M M
A'

. ff ' d d

−
=
  ′− − γ 

    (BS 3.4.4.4)  
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where d ' is the depth of the compression steel from the concrete compression 
face, and 

sf ′  = 0.87 fy  if 
1 1
2 800
 ′ ≤ − 
 

yfd
d  (BS 3.4.4.4) 

css Ef ε=' 21
′ −  

d
d

 if 
1 1
2 800
 ′ > − 
 

yfd
d  (BS 3.4.4.4) 

 Spandrel 0.5 0.25 .
0.9
Kz d

 ′ = + − 
 

    
      

(BS 3.4.4.4) 

This is the bottom steel if the section is under negative moment. From 
equilibrium, the area of tension reinforcement is calculated as 

 
( )

single single

0 87 0 87s
y y

M M M
A

. f z . f d d
−

= +
′−

     (BS 3.4.4.4) 

4.1.2.2 T-Beam Flexural Reinforcing 
T-beam action is considered effective for positive moment only. When 
designing T-beams for negative moment (i.e., designing top steel), the 
calculation of required steel is as described in the previous section for 
rectangular sections. No T-beam data is used in this design. The width of the 
beam is taken equal to the width of the web. 

With the flange in compression, the program analyzes the section by 
considering alternative locations of the neutral axis. Initially, the neutral axis is 
assumed to be located in the flange. Based on this assumption, the program 
calculates the exact depth of the neutral axis. If the stress block does not extend 
beyond the flange thickness, the section is designed as a rectangular beam of 
width bf. If the stress block extends beyond the flange width, the contribution 
of the web to the flexural strength of the beam is taken into account. See Figure 
4-2. 
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Figure 4-2: Design of a Wall Spandrel with a T-Beam Section, Positive Moment 

 If a ≤ ds, the subsequent calculations for As are exactly the same as 
previously defined for the Rectangular section design. However, in that 
case, the width of the compression flange, bf , is taken as the width of the 
beam, b, for analysis. Compression reinforcement is required if .′>K K  

 If a > ds, the subsequent calculations for the required area of reinforcing 
steel are performed in two parts. First, the tension steel required to balance 
the compressive force in the flange is determined, and second, the tension 
steel required to balance the compressive force in the web is determined. If 
necessary, compression steel is added to help resist the design moment. 

The remainder of this section describes in detail the design process used by the 
program for T-beam spandrels when a > ds. 

Note: T-beam action is considered for positive moment only. 

In that case, the ultimate resistance moment of the flange is given by 

 ( ) ( )Spandrel
0.67 0.5 ,f cu f s s s

c

M f b t d d d= − −
γ

 

the balance of moment taken by the web is computed as 

 ,w fM M M= −  and 

the normalized moment resisted by the web is given by 
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 2
Spandrel

.w
w

cu s

M
K

f t d
=  

4.1.2.2.1 Tension Reinforcing Only Required 
If Kw ≤ K1, the beam is designed as a singly reinforced concrete beam. The area 
of steel is calculated as the sum of two parts, one to balance compression in the 
flange and one to balance compression in the web. 

 
( )Spandrel

,
0.870.87 0.5

f w
s

yy s

M M
A

f zf d d
= +

−
 where 

 Spandrel Spandrel0.5 0.25 0.95 .
0.9

wK
z d d

  = + − ≤ 
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4.1.2.2.2 Tension and Compression Reinforcing Required 
If ,wK K ′>  compression reinforcement is required and is calculated as follows:  

The ultimate moment of resistance of the web only is given by 

 2
Spandrel .uw cu sM K f t d′=  

The compression reinforcement is required to resist a moment of magnitude  
Mw − Muw. The compression reinforcement is computed as 

 
( )Spandrel

,w uw
s

s

M M
A

f d d

−′ =
′ ′−

   

where, d' is the depth of the compression steel from the concrete compression 
face, and 

ys ff 87.0' =   if 
1 1
2 800
 ′ ≤ − 
 

yfd
d   (BS 3.4.4.4) 
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



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d
dEf css

'21' ε   if 
1 1
2 800
 ′ > − 
 
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The area of tension reinforcement is obtained from equilibrium 

Spandrel Spandrel

1 ,
0.87 0.5

f uw w uw
s

y s

M M M M
A

f d d z d d
 −

= + + 
′− −  

 where  

Spandrel Spandrel0.5 0.25 0.95 .
0.9
kz d d

 ′ = + + ≤ 
 

 

The total tension reinforcement, As, is to be placed at the bottom of the beam, 
and As' at the top of the beam. 

4.1.2.2.3 Minimum and Maximum Tensile Reinforcement 
The minimum flexural tensile steel required for a beam section is given by the 
following table, which is taken from BS Table 3.25 (BS 3.12.5.3) with 
interpolation for reinforcement of intermediate strength: 

Section Situation 
Definition of 
percentage 

Minimum percentage 

fy = 250 MPa fy = 460 MPa 

Rectangular  100 s

s s

A
t h

 0.24 0.13 

T- or L-Beam with web 
in tension 

s

f

t
b

< 0.4 100 s

s s

A
t h

 0.32 0.18 

s

f

t
b

≥ 0.4 100 s

s s

A
t h

 0.24 0.13 

T-Beam with web in 
compression 

 100 s

s s

A
t h

 0.48 0.26 

L-Beam with web in 
compression 

 100 s

s s

A
t h

 0.36 0.20 
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The minimum flexural compression steel provided in a rectangular or T-beam 
section, if it is required at all, is given by the following table, which is taken 
from BS Table 3.25 (BS 3.12.5.3) with interpolation for reinforcement of 
intermediate strength: 

Section Situation 
Definition of  
percentage 

Minimum  
percentage 

Rectangular  100 s

s s

A
t h
′

 0.20 

T-Beam 

Web in tension 100 s

f s

A
b d

′
 0.40 

Web in compression 100 s

s s

A
t h
′

 0.20 

 
In addition, an upper limit on both the tension reinforcement and compression 
reinforcement has been imposed to be 0.04 times the gross cross-sectional area 
(BS 3.12.6.1). 

4.2 Spandrel Shear Design 
The program allows consideration of rectangular sections and T-beam sections 
for wall spandrels. The shear design for both of these types of spandrel sections 
is identical. 

The wall spandrel shear reinforcing is designed for each of the design load 
combinations. The required area of reinforcing for vertical shear is calculated 
at the ends of the spandrel beam only. 

In this program, wall spandrels are designed for major direction flexure and 
shear forces only. Effects caused by any axial forces, minor direction bending, 
torsion or minor direction shear that may exist in the spandrels must be 
investigated by the user independent of the program. 

The following steps are involved in designing the shear reinforcing for a 
particular wall spandrel section for a particular design loading combination at a 
particular station. 

 Determine the factored shear force V. 
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 Determine the shear force, vc, that can be carried by the concrete. 

 Determine the required shear reinforcing to carry the balance of the shear 
force. 

Note: In the overwrites, vc can be specified to be ignored (set to zero) for span-
drel shear calculations. 

Step 1 needs no further explanation. The following two sections describe in 
detail the algorithms associated with Steps 2 and 3. 

4.2.1 Determine the Concrete Shear Capacity 
The shear reinforcement is designed for each loading combination in the major 
and minor directions of the column. In designing the shear reinforcement for a 
particular beam for a particular loading combination due to shear forces in a 
particular direction, the following steps are involved: 

 Calculate the design shear stress as 

 Spandrel, ,  wherecv s
cv

Vv A t d
A

= =  (BS 3.4.5.2) 

 LW0.8R ,cuv f≤  and (BS 3.4.5.2) 

 2
N

mm5 .v ≤   (BS 3.4.5.2) 

If v exceeds either 0.8 cuf or 2
N

mm5 ,  the section area should be increased. 

 Calculate the design concrete shear stress from 

 
cc

c
c

cc vA
Nv

MA
NVhvv +≤+= 16.0'   (BS 3.4.5.12) 

 
1 1

3 4
1 2 1000.79 400 ,

γ
   =      

s
c

m

Ak kv
bd d

  (BS 3.4.5.4, Table 3.8) 

where,  

k1 is the enhancement factor for support compression, 
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and 1k   is conservatively taken as 1,  (BS 3.4.5.8) 

k2 =  
1

3
1

25
  ≥ 
 

cuf
  (BS 3.4.5.4, Table 3.8) 

1.25.mγ =   (BS 2.4.4.1) 

However, the following limitations also apply: 

1000.15 3,≤ ≤sA
bd

  (BS 3.4.5.4, Table 3.8) 

4
1

400








d
 ≥ 0.67 (unreinforced) or ≥ 1 (reinforced)(BS 3.4.5.4, Table 3.8) 

fcu ≤ 40 MPa (for calculation purpose only) (BS 3.4.5.4, Table 3.8) 

1≤
M
Vh

 (BS 3.4.5.12) 

Note: The term RLW that is used as a multiplier on all cuf  terms in this 
manual is a shear strength reduction factor that applies to light-weight 
concrete. It is equal to 1 for normal weight concrete. This factor is specified in 
the concrete material properties. 

4.2.2 Determine the Required Shear Reinforcing 
One of the terms used in calculating the spandrel shear reinforcing is dspandrel, 
which is the distance from the extreme compression fiber to the centroid of the 
tension steel. For shear design, the program takes dspandrel to be equal to the 
smaller of hs − dr-top and hs − dr-bot. 

 Calculate the design average shear stress that can be carried by minimum 
transverse rebar, vr as follows: 

2
N

mm0.4=rv  (BS 3.4.5.3, Table 3.7) 

sA  is the area of tensile steel. 
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If ,≤ +c rv v v  provide minimum links defined by 

,
0.87

=s r

v yv

A v b
s f  

(BS 3.4.5.3, Table 3.7) 

else if > +c rv v v , provide links given by 

( )
.

0.87
csv

v yv

v v bA
s f

−
=  (BS 3.4.5.3, Table 3.7) 

Note: The output units for the distributed shear reinforcing can be set in the 
shear wall design preferences. 
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Chapter 5 
Design Output 

The program has the capacity to create design output in four major ways – 
graphical display, file output, tabular display, and member specific detailed 
design information. The graphical display includes input and output design 
information for members visible in the active window; the display can be 
sent directly to a printer or saved to a file. The file output includes both 
summary and detail design data that can be saved in RTF, HTML and plain 
text formats.  The tabular display output includes both summary and detail 
design data that can be displayed or saved in many formats, including Excel, 
Access, RTF, HTML and plain text. The member specific detailed design 
information shows the details of the calculation.  

The following sections describe some of the typical graphical display, file 
output, tabular display output, and member specific detailed design 
information. Some of the design information is very specific to the chosen 
shear wall design code. This manual addresses "Singapore CP 65:1999" 
design code related output information only.  

5.1 Graphical Display of Design Information 
The graphical display of design output includes input and output design 
information for all shear wall members that are visible in the active window. 
The graphical output can be produced in color or in gray-scaled screen 
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display. The active screen display can be sent directly to the printer or saved 
to a file in several formats.  

Use the Design menu > Shear Wall Design > Display Design Info 
command to display on-screen output plotted directly on the model. If 
desired, the screen graphics can then be printed using the File menu > Print 
Graphics command. The on-screen display data is organized into two main 
groups, as follows. 

Design Input 

 Material 

 Thickness 

 Pier length/spandrel depth 

 Section Designer pier sections 

Design Output 

 Simplified pier longitudinal reinforcing 

 Simplified pier edge members 

 Section Designer pier reinforcing ratios 

 Section Designer pier D/C ratios 

 Spandrel longitudinal reinforcing 

 Shear reinforcing 

 Pier demand/capacity ratios 

 Pier boundary zones 

Note that you cannot display more than one of the listed items on the model 
at the same time.  

The output plotted directly on piers is plotted along an invisible line that 
extends from the centroid of the pier section at the bottom of the pier to the 
centroid of the pier section at the top of the pier. Similarly, the output plotted 
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directly on spandrels is plotted along an invisible line that extends from the 
centroid of the spandrel section at the left end of the spandrel to the centroid 
of the spandrel section at the top of the spandrel. 

The onscreen graphical display can be sent to printer using any of the 
following commands. Use the File menu > Print Graphics command to 
print the active window. To capture the graphical display in a file for printing 
through another application, use the File menu > Capture Enhanced 
Metafile command to create an .emf file, or use the File menu > Capture 
Picture command to create a bitmap (.bmp) file. Create a screen capture of 
the active window using the Alt+ Print Screen keyboard keys or create a 
screen capture of the entire window using the Ctrl + Print Screen keyboard 
keys. Then use the Ctrl+V keyboard keys to paste the saved image into Paint 
or other graphical program.  

5.2 Tabular Display of Design Information 
In addition to model definition and analysis results, the design information 
for all piers and spandrels or for only selected piers and spandrels can be 
displayed in tabular spreadsheet format. Currently, the program generates 
design pier location data,  pier basic overwrite data, uniform reinforcing 
sections, general reinforcing sections, simplified T and C sections, spandrel 
location data, spandrel basic overwrite data, and spandrel geometry data. The 
tabular spreadsheet output can be displayed by selecting the Display menu > 
Show Tables command to access the Choose Tables for Display form. That 
form can be used to choose which tables or sets of tables are to be displayed.  

The names of the tables are displayed in a tree structure, which can be 
collapsed or expanded by clicking on an item in the tree. Click on the small 
check boxes preceding the items to select those tables for display. If a branch 
of the tree is selected, all of the tables under that branch are selected. The 
selected set of tables can be saved as a Named Set using the Save Named Set 
button. This named set can be used in the future for quick selection. If one or 
more frame members are selected on the structural model before accessing 
the Choose Tables for Display form, the Selection Only check box will be 
checked when the form displays and, the program will display information 
for the selected members only; uncheck the check box to display information 
for all applicable "unselected" members in the model. If the Show 

 Tabular Display of Design Information 5-3 



Shear Wall Design BS 8110-1997 
 

Unformatted check box is checked, the numbers will be displayed 
unformatted, instead of being displayed using a limited number of decimal 
digits. The unformatted option provides higher precision output that can then 
be copied into other programs.  

Use the other buttons in the form to tailor the data display. For example, 
click the Select Load Cases button to specify which load cases are to be 
included in the display of model definition data; click the Select Analysis 
Case and Modify/Show Options to specify which analysis cases are to be 
included and how analysis results are displayed.  

After selecting all of the tables for shear wall design and the display options, 
click the OK button to display a form showing one of the selected design 
tables, with a drop-down list in the upper right-hand corner of the form that 
can be used to select other tables for display.  

Use the scroll bars on the bottom and right side of the tables to scroll right 
and left or up and down if portions of the data table can not be displayed in 
the form's display area. The columns can be resized by clicking the left 
mouse button on the separator of the headers, holding down the left mouse 
button and then dragging the mouse to the left or right. Reset the column 
widths to their default values by selecting the Format-Filter-Sort menu > 
Reset Default Column Widths command on the form. The table can be split 
into two or more tables by clicking on the small black rectangular area near 
the bottom-left corner of the table, holding down the left mouse button, and 
then dragging the mouse button to the left or right. Repeat this process to add 
more splits. Use the split and horizontal scroll bar to put two columns side by 
side for easier comparison. The splits can be removed by selecting the 
Format-Filter-Sort menu > Remove Splits command on the form. 
Alternatively, remove the split by clicking, holding and dragging the left 
mouse button to merge the split key to its original location.  

Select multiple consecutive columns by putting the cursor on the header, 
holding down the mouse button, and then dragging the mouse button left or 
right. Alternatively, depress the Shift key and click the left mouse button to 
select a range of columns.  

Each of the individual fields (columns) can be formatted. Fields with text 
information can be set for specific types of alignment (center, left, right) and 
to specific widths. In addition to setting the alignment and column widths, 
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fields with numeric data can be set for the maximum number of characters, 
zero tolerance, number of decimal digits and so forth. The tables can be 
formatted, filtered and sorted using multiple criteria accessed using the 
Format-Filter-Sort menu on the form. Filtering and sorting features can be 
useful in identifying critical cases. After specifying the table formatting 
information, save it to a format file that can be used in the future by selecting 
the appropriate feature available under the Format-Filter-Sort menu. 

The current table (i.e., the table in the active window) can be exported to 
Excel, Access, .rtf., .html, and plain text formats. In both Excel spreadsheet 
and Access database formats, the tables can have many columns, making the 
tables very wide. In .rft and .html formats, the tables are split at convenient 
points to make a reasonably printable document. In plain text format, the 
tables can be saved with or without the splits. To export a table to Excel, for 
example, select the File menu > Export Current Table > To Excel 
command. The program will export the entire table to an Excel spreadsheet 
workbook and will automatically open the file in MS Excel. Similarly, if the 
table is exported to other formats, the default editor specific to that format 
will open the document, provided that the editor is available in the computer. 
The table will be saved in that format only if the relevant editor is not 
available. Instead of exporting or displaying the currently displayed table, the 
entire set of available tables can be exported and displayed in the afore-
mentioned formats by selecting the File menu and the appropriate submenu 
command. With these exporting and display features, the tables can be saved 
in many required formats and can be printed. Many other features of the 
design tables are left for the user to discover by using the program. 

5.3 Detailed Display of Member Specific Information 
Interactive design is a powerful mode that allows quick, on-screen review of 
design results for a specific pier or spandrel. This mode allows easy 
modification to design parameters (overwrites) and immediate review of the 
new results. 

Note that a design must have been run for the interactive design mode to be 
available. To run a design, click the Design menu > Shear Wall Design > 
Start Design/Check of Structure command. 
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To enter the interactive design and review mode, right click on a wall pier or 
spandrel while the design results are displayed. If design results are not 
currently displayed (and the design has been run), click the Design menu > 
Shear Wall Design > Interactive Wall Design command and then right 
click a pier or spandrel to enter the interactive design and review mode for 
that pier or spandrel. 

Note that if both a pier and a spandrel label are assigned to the right-clicked 
object, a pop-up box offers the choice to enter the interactive design and 
review mode for the pier or for the spandrel. Appendix E provides additional 
information about interactive shear wall design. 

5.4 Output of Design Information 
In addition to model definition and analysis results, the design information 
for all piers and spandrels or for selected piers and spandrels only can be 
saved in tabular format. For BS 8110-1997 code, the program saves 
simplified pier longitudinal reinforcing, simplified pier edge members, 
Section Designer pier reinforcing ratios, section Designer pier D/C ratios, 
spandrel longitudinal reinforcing, shear reinforcing, sier demand/capacity 
ratios and pier boundary zones.  Save the file output by selecting the File 
menu > Print Tables command to access the Choose Tables for Printing 
form. Use the options on the form to choose which table or set of tables to 
save in a file or print. This form is very similar to the Choose Tables for 
Display form, which has been described earlier in this chapter in the "Tabular 
Display of Design Information" section. 

The name of the tables are displayed in a tree structure, which can be 
collapsed or expanded by clicking on an item in the tree. Click on the small 
check boxes preceding the items to select those tables for printing or saving 
to a file. If a branch of the tree is selected, all of the tables under that branch 
are selected.  When all options for printing or saving the data to file have 
been specified, the settings can be saved as a Named Set using the Save 
Named Set button. The Named Set can be easily recalled in the future, 
reducing the need to reselect the options and ensuring that output is 
consistent from one printing effort to another. 

If one or more structural members are selected before the Choose Tables for 
Printing form is accessed, the Selection Only check box will be checked, and 
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the program will save or print the data for the selected members only; 
uncheck the check box to save or print the data for all appropriate 
"unselected" members. 

The output can be generated in a variety of formats, including rich text 
format (.rft), plain text with and without splits or page breaks (.txt), and 
hyperlink text markup language (.htm) by choosing the appropriate option on 
the right side of the form.  

Printed output can be specified to have a landscaped orientation, in which the 
width of the resulting printout on a given page is longer than the height of the 
printout.  

Filtering criteria can be applied if those criteria were specified using the 
Format-Filter-Sort menu > Format Table command when the selected 
data tables were displayed using the Display menu > Show Tables 
command. The output also can be specified to include a hyperlinked contents 
to facilitate accessing specific areas of the printout. 

There are other buttons on the form that do not affect saving or printing 
design information. For example, the Select Load Cases button affects only 
saving/printing model definition data. The Select Analysis Cases and 
Modify/Show Options buttons affect only saving/printing analysis results. 

After clicking all the necessary tables for steel frame design and all necessary 
options, clicking the OK button will save/print the design tables. 

Although the File name > Print Tables command path is dedicated for 
saving/printing design information, it is not the only path to do so. Design 
tables can be saved in different formats using the path Display menu > 
Show Tables command. 

5.5 Error Messages and Warnings 
Error messages and warnings may be displayed in the shear wall design 
output. The messages are assumed to be self-explanatory. 
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Appendix A 
Shear Wall Design Preferences 

The shear wall design preferences are basic properties that apply to all wall 
pier and spandrel elements. Table B1 identifies shear wall design preferences 
for BS 8110-1997. Default values are provided for all shear wall design 
preference items. Thus, it is not required that preferences be specified. 
However, at least review the default values for the preference items to make 
sure they are acceptable. Refer to the program Help for an explanation of 
how to change a preference. 

Table A1  Shear Wall Preferences 
 

Item 
Possible 
Values 

Default 
Value 

 
Description 

Design Code Any code in the 
program 

UBC 97 Design code used for design of concrete 
shear wall elements (i.e., wall piers and 
spandrels) 

Time History  
Design 

Envelopes or 
Step-by-Step 

Envelopes Toggle for design load combinations that 
include a time history designed for the 
envelope of the time history, or designed 
step-by-step for the entire time history. If a 
single design load combination has more 
than one time history case in it, that design 
load combination is designed for the 
envelopes of the time histories, regardless of 
what is specified here. 
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Table A1  Shear Wall Preferences 
 

Item 
Possible 
Values 

Default 
Value 

 
Description 

Rebar units in2, cm2, mm2, 
current 

in2 or mm2 Units used for concentrated areas of 
reinforcing steel.. 

Rebar/Length 
Units 

in2/ft, cm2/m, 
mm2/m, 
current 

in2/ft or mm2/m Units used for distributed areas of reinforcing 
steel. 

Gamma (Steel) > 0 1.15 The material strength reduction factor for 
Steel. 

Gamma 
(Concrete) 

> 0 1.5 The material strength reduction factor for 
Concrete. 

Gamma 
(Concrete 
Shear) 

> 0 1.25 The material strength reduction factor for 
Concrete in shear. 

Number of 
Curves 

≥ 4 24 Number of equally spaced interaction curves 
used to create a full 360-degree interaction 
surface (this item should be a multiple of 
four). We recommend that you use 24 for this 
item.  

Number of 
Points 

≥ 11 11 Number of points used for defining a single 
curve in a wall pier interaction surface (this 
item should be odd).. 

Edge Design 
NT-max 

> 0 0.06 Maximum ratio of tension reinforcing allowed 
in edge members, NTmax..  

Edge Design 
NC-max 

> 0 0.04 Maximum ratio of compression reinforcing 
allowed in edge members, NCmax.  

Section Design 
IP-Max 

≥ Section  
Design IP-Min 

0.02 The maximum ratio of reinforcing considered 
in the design of a pier with a Section 
Designer section. 

Section Design 
IP-Min 

> 0 0.0025 The minimum ratio of reinforcing considered 
in the design of a pier with a Section 
Designer section. 

Utilization Factor 
limit 

>0 0.95 Used to determine the capacity of the 
section. 
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Appendix B   
Design Procedure Overwrites 

The shear wall design overwrites are basic assignments that apply only to 
those piers or spandrels to which they are assigned. The overwrites for piers 
and spandrels are separate. Tables B1 and B2 identify the shear wall 
overwrites for piers and spandrels, respectively, for BS 8110-1997. Note that 
the available overwrites change depending on the pier section type (Uniform 
Reinforcing, General Reinforcing, or Simplified T and C).   

Default values are provided for all pier and spandrel overwrite items. Thus, it 
is not necessary to specify or change any of the overwrites. However, at least 
review the default values for the overwrite items to make sure they are 
accept-able. When changes are made to overwrite items, the program applies 
the changes only to the elements to which they are specifically assigned; that 
is, to the elements that are selected when the overwrites are changed. Refer to 
the program Help for an explanation of how to change the overwrites. 

 

Table B-1: Pier Design Overwrites 

Pier Overwrite 
Item 

Possible 
Values 

Default 
Value 

 
Pier Overwrite Description 

Design this Pier Yes or No Yes Toggle to design the pier when the Design 
menu > Shear Wall Design > Start Design 
command is clicked. 
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Table B-1: Pier Design Overwrites 

Pier Overwrite 
Item 

Possible 
Values 

Default 
Value 

 
Pier Overwrite Description 

LL Reduction 
Factor 

Program  
calculated,  

> 0 

Program  
calculated 

A reducible live load is multiplied by this 
factor to obtain the reduced live load. 
Entering 0 for this item means that it is 
program calculated. See the "LL Reduction 
Factor" section in the appendix for more 
information. 

Pier Section 
Type 

Uniform  
Reinforcing,  

General  
Reinforcing,  
Simplified  
T and C 

Uniform 
Reinforcing 

Indicates the type of pier. The General 
Reinforcing option is not available unless 
General pier sections previously have been 
defined in Section Designer.  

Overwrites Applicable to Uniform Reinforcing Pier Sections  
Edge Bar  
Name 

Any defined  
bar size 

Varies The size of the uniformly spaced edge bars. 

Edge Bar 
Spacing 

>0 12" The spacing of the uniformly spaced edge 
bars. 

End/Corner  
Bar Name 

Any defined  
bar size 

Varies The size of end and corner bars. 

Clear Cover >0 1.5" The clear cover for the edge, end and 
corners bars. 

Material Any defined 
concrete 

material property 

Varies The material property associated with the 
pier. 

Check/Design 
Reinforcing 

Check or  
Design 

Design This item indicates if the pier section is to 
be designed or to be checked. 

Overwrites Applicable to General Reinforcing Pier Sections  
Section Bottom Any general pier 

section defined 
in Section 
Designer 

The first pier in 
the list of 
Section 

Designer piers 

Name of a pier section, defined in Section 
Designer that is assigned to the bottom of 
the pier.  

Section Top Any general pier 
section defined 

in  
Section  

Designer 

The first pier in 
the list of  
Section  

Designer piers 

Name of a pier section, defined in Section 
Designer, that is assigned to the top of the 
pier.  

Check/Design 
Reinforcing 

Check or  
Design 

Design This item indicates whether the pier section 
is to be designed or checked. 
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Table B-1: Pier Design Overwrites 

Pier Overwrite 
Item 

Possible 
Values 

Default 
Value 

 
Pier Overwrite Description 

Overwrites Applicable to Simplified T and C Pier Sections  
ThickBot Program  

calculated,  
or > 0 

Program  
calculated 

Wall pier thickness at bottom of pier, tp. 
Inputting 0 means the item is to be program 
calculated. 

LengthBot Program  
calculated,  

or > 0 

Program  
calculated 

Wall pier length at bottom of pier, Lp. 
Inputting 0 means the item is to be program 
calculated. 

DB1LeftBot ≥ 0 0 Length of the bottom of a user-defined edge 
member on the left side of a wall pier, 
DB1left.  

DB2LeftBot ≥ 0 0 Width of the bottom of a user-defined edge 
member on the left side of a wall pier, 
DB2left. See Figure 1 in Shear Wall Design 
Technical Note 6 Wall Pier Design Section. 
See the subsection entitled "User-Defined 
Edge Members" for more information. 

DB1RightBot ≥ 0 Same as 
DB1-left-bot 

Length of the bottom of a user-defined edge 
member on the right side of a wall pier, 
DB1right.  

DB2RightBot ≥ 0 Same as 
DB2-left-bot 

Width of the bottom of a user-defined edge 
member on the right side of a wall pier, 
DB2right.  

ThickTop Program  
calculated,  

or > 0 

Program  
calculated 

Wall pier thickness at top of pier,  tp. 
Inputting 0 means the item is to be program 
calculated. 

LengthTop Program  
calculated,  

or > 0 

Program  
calculated 

Wall pier length at top of pier, Lp. Inputting 0 
means the item is to be program calculated. 

DB1LeftTop ≥ 0 0 Length of the top of a user-defined edge 
member on the left side of a wall pier, 
DB1left.  

DB2LeftTop ≥ 0 0 Width of the top of a user-defined edge 
member on the left side of a wall pier, 
DB2left.  

DB1RightTop ≥ 0 Same as 
DB1-left-bot 

Length of the top of a user-defined edge 
member on the right side of a wall pier, 
DB1right.  

DB2RightTop ≥ 0 Same as 
DB2-left-bot 

Width of the top of a user-defined edge 
member on the right side of a wall pier, 
DB2right.  
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Table B-1: Pier Design Overwrites 

Pier Overwrite 
Item 

Possible 
Values 

Default 
Value 

 
Pier Overwrite Description 

Material Any defined  
concrete  
material  
property 

 Material property associated with the pier.  

Edge Design  
NC-max 

> 0 Specified in  
Preferences 

Maximum ratio of compression  
reinforcing allowed in edge members, 
NCmax.  

Edge Design  
NT-max 

> 0 Specified in  
Preferences 

Maximum ratio of tension reinforcing 
allowed in edge members, NTmax.  

B.1 LL Reduction Factor 
If the LL Reduction Factor is program calculated, it is based on the live load 
reduction method chosen in the live load reduction preferences (setting these 
preferences is explained in the program-specific on-line Help). If a user 
specifies a LL Reduction Factor, the program ignores any reduction method 
specified in the live load reduction preferences and simply calculates the 
reduced live load for a pier or spandrel by multiplying the specified LL 
Reduction Factor times the reducible live load. 

Note that the steps required to define a load case as a reducible live load can 
be found in the program-specific on-line Help. 

Important Note: The LL reduction factor is not applied to any load 
combination that is included in a design load combination. For example, 
assume two static load cases are labeled DL and RLL. DL is a dead load and 
RLL is a reducible live load. Now assume a design load combination named 
DESCOMB1 includes DL and RLL. Then for design load combination 
DESCOMB1, the RLL load is multiplied by the LL reduction factor. Next 
assume a load combination called COMB2 includes RLL. Now assume a 
design load combination is created called DESCOMB3 that included the DL 
and COMB2. For design load combination DESCOMB3, the RLL load that 
is part of COMB2 is not multiplied by the LL reduction factor. 

B.2 User-Defined Edge Members 
When defining a user-defined edge member, both a nonzero value for DB1 
and a nonzero value for DB2 must be specified. If either DB1 or DB2 is 
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specified as zero, the edge member width is taken as the same as the pier 
thickness, and the edge member length is determined by the program. 

Table B-2 Spandrel Design Overwrites 
Spandrel 

Overwrite Item 
Possible 
Values 

Default 
Value 

 
Spandrel Overwrite Description 

Design this 
Spandrel 

Yes or No Yes Toggle for design of the spandrel when you 
click the Design menu > Shear Wall 
Design > Start Design command. 

LL Reduction 
Factor 

Program  
calculated,  

> 0 

Program  
calculated 

A reducible live load is multiplied by this 
factor to obtain the reduced live load. 
Entering 0 for this item means that it is 
program calculated. See the "LL Reduction 
Factor" in this appendix for more 
information. 

Length Program  
calculated,  

or > 0 

Program  
calculated 

Wall spandrel length, Ls. Inputting 0 means 
the item is to be program calculated. 

ThickLeft Program  
calculated,  

or > 0 

Program  
calculated 

Wall spandrel thickness at left side of 
spandrel, ts. Inputting 0 means the item is to 
be program calculated. 

DepthLeft Program  
calculated,  

or > 0 

Program  
calculated 

Wall spandrel depth at left side of spandrel, 
hs. Inputting 0 means the item is to be 
program calculated. 

CoverBotLeft Program  
calculated,  

or > 0 

Program  
calculated 

Distance from bottom of spandrel to 
centroid of bottom reinforcing, dr-bot left on left 
side of beam. Inputting 0 means the item is 
to be program calculated as 0.1hs. 

CoverTopLeft Program  
calculated,  

or > 0 

Program  
calculated 

Distance from top of spandrel to centroid of 
top reinforcing, dr-top left on left side of beam. 
Inputting 0 means the item is to be program 
calculated as 0.1hs. 

SlabWidthLeft ≥ 0 0 Slab width for T-beam at left end of 
spandrel, bs.  

SlabDepthLeft ≥ 0 0 Slab depth for T-beam at left end of 
spandrel, ds. 

ThickRight Program  
calculated,  

or > 0 

Program  
calculated 

Wall spandrel thickness at right side of 
spandrel, ts. Inputting 0 means the item is to 
be program calculated. 

DepthRight Program  
calculated,  

or > 0 

Program  
calculated 

Wall spandrel depth at right side of 
spandrel, hs. Inputting 0 means the item is 
to be program calculated. 
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Table B-2 Spandrel Design Overwrites 
Spandrel 

Overwrite Item 
Possible 
Values 

Default 
Value 

 
Spandrel Overwrite Description 

CoverBotRight Program  
calculated,  

or > 0 

Program  
calculated 

Distance from bottom of spandrel to 
centroid of bottom reinforcing, dr-bot right on 
right side of beam. Inputting 0 means the 
item is to be program calculated as 0.1hs. 

Cover- 
TopRight 

Program  
calculated,  

or > 0 

Program  
calculated 

Distance from top of spandrel to centroid of 
top reinforcing, dr-top right on right side of 
beam. Inputting 0 means the item is to be 
program calculated as 0.1hs. 

SlabWidthRight ≥ 0 0 Slab width for T-beam at right end of 
spandrel, bs.  

SlabDepthRight ≥ 0 0 Slab depth for T-beam at right end of 
spandrel, ds.  

Material Any defined  
concrete 
material  
property 

"Default Design 
Material  
Property  

Material property associated with the 
spandrel. 

Consider Vc Yes or No Yes Toggle switch to consider Vc (concrete 
shear capacity) when computing the shear 
capacity of the spandrel. 
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Appendix C  
Analysis Sections and Design Sections 

It is important to understand the difference between analysis sections and 
design sections when performing shear wall design. Analysis sections are 
simply the objects defined in a model that make up the pier or spandrel section. 
The analysis section for wall piers is the assemblage of wall and column 
sections that make up the pier. Similarly, the analysis section for spandrels is 
the assemblage of wall and beam sections that make up the spandrel. The 
analysis is based on these section properties, and thus, the design forces are 
based on these analysis section properties. 

The design section is completely separate from the analysis section. Two types 
of pier design sections are available.  

 Uniform Reinforcing Section: For flexural designs and/or checks, the 
program automatically (and internally) creates a Section Designer pier 
section of the same shape as the analysis section pier. Uniform reinforcing is 
placed in this pier. The reinforcing can be modified in the pier overwrites. 
The Uniform Reinforcing Section pier may be planar or it may be three-
dimensional. 

For shear design and boundary zone checks, the program automatically (and 
internally) breaks the analysis section pier into planar legs and then performs 
the design on each leg separately and reports the results separately for each 
leg. Note that the planar legs are derived from the area objects defined in the 
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model, not from the pier section defined in Section Designer. The pier 
section defined in Section Designer is used for the flexural design/check 
only. 

 General Reinforcing Section: For flexural designs and/or checks the pier 
geometry and the reinforcing is defined by the user in the Section Designer 
utility. The pier defined in Section Designer may be planar or it may be 
three-dimensional. 

For shear design and boundary zone checks, the program automatically (and 
internally) breaks the analysis section pier into planar legs and then performs 
the design on each leg separately and reports the results separately for each 
leg. Note that the planar legs are derived from the area objects defined in the 
model, not from the pier section defined in Section Designer. The pier 
section defined in Section Designer is used for the flexural design/check 
only. 

 Simplified Pier Section: This pier section is defined in the pier design 
overwrites. The simplified section is defined by a length and a thickness. The 
length is in the pier 2-axis direction and the thickness is in the pier 3-axis 
direction.  

In addition, if desired, the thickened edge members at one or both ends of the 
simplified pier section can be specified. Reinforcing cannot be specified in a 
simplified section. Thus, the simplified section can be used for design only, 
not for checking user-specified sections. Simplified sections are always 
planar. 

Only one type of spandrel design section is available. It is defined in the 
spandrel design overwrites. A typical spandrel is defined by a depth, 
thickness and length. The depth is in the spandrel 2-axis  direction; the 
thickness is in the spandrel 3-axis direction; and the length is in the spandrel 
1-axis direction. Spandrel sections are always planar. In addition, if desired, a 
slab thickness and depth can be specified, making the spandrel design section 
into a T-beam. Reinforcing cannot be specified in a spandrel section. Thus, 
spandrel sections can be designed only, not check. 
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The pier and spandrel design sections are designed for the forces obtained 
from the program's analysis, which is based on the analysis sections. In other 
words, the design sections are designed based on the forces obtained for the 
analysis sections. 
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